
How to purchase

Pricing
The license fee for AD Picture Viewer is $25.00 US. If you are part of a business and wish to use several 
copies of AD Picture Viewer within your company, greatly reduced site licensing rates are also available.

To link to our web site for general pricing information goto here: 
www.abroaddesign.com/picview/register.html

Ordering
For your convenience and protection, we provide the following secure methods of ordering:

Telephone

FAX

Internet



Formats supported

Read support
BMP, RLE, DIB Windows Bitmaps Supported all types of Windows bitmaps: 

2/8/16/24/32 bpp, RLE and uncompressed and 
device independent.

GIF Graphics Interchange Format Single page (GIF86a) amd animated (GIF89a). 
JPEG JPEG JFIF JFIF and Adobe CMYK.
PNG Portable Network Graphics All types.
TIFF Tag Image File Format Base line implementation, 8 and 16 bits per 

channel, byte order: little endian, big endian, color 
spaces: B&W, 256 colors, 4, 8 and 16 bit gray 
scale, CMYK, L*a*b*, RGB, RGBA 
(uncompressed, LZW).

PCX ZSoft Publisher’s Paintbrush All types.
PSP, PDD PhotoShop Document RGB, grayscale, duotone, paletted and bi-level.
TGA, VDA, ICB, VST Targa TGA All types.
PPM,PGM,PBM Portable pixel/gray map B&W, gray scale, RGB (uncompressed), ASCII 

and Binary formats
ICO Windows Icon All types.
WMF, EMF Windows Metafile Format Embeded and Enhanced metafiles.

Write support*
BMP Windows bitmaps All subtypes
GIF Graphics Interchange Format GIF86a
JPG JPEG JFIF RGB TrueColor

* AD Picture Viewer save only acrive frame as static image then the GIF89a (Animated GIF) is loaded 



Multilanguage support

AD Picture Viewer supports creation and use of interface resources for work with native languages.

This information discribes the method if self creation of the language resources for AD Picture Viewer.

The language resources is in the LNG files in program installing folder.

To make a new resource copy existing LNG file (Englist.lng for example) with new name.

Open the new language file in some text editor (Notepad.EXE for example).

This file containing the list of interface controls and messages names and their values, that would be 
displayed in run-time. Replace the values of controls and messages to language-oriented in 
[Translations] an [Messages] sections. The "&" symbol shows that the next symbol is used for quick 
command. For example:

MainForm.Help1.Caption=&Help (English) replace to

MainForm.Help1.Caption=&Aynda (Espanol).

The next step is change of value of Name variable in [Common] section - this is the name of language of 
the resource file that will be used for the language identification.

After saving and start program this language resource will be automatically plug in to program. To 
change the language use the "Configuration" window ("Language" page).

Information for these who have created new language resources which were not created earlier and are 
nod distributes with the program or without it. In the case you would share your own language resources 
files with the author of the program you will be able to register your copy of program free of charge. For 
this purpose send us a letter with your address and your files (us e-mail is 
support@abroaddesign.hypermart.net). The list of already existing language resources you can find in 
Internet (see "About" window). The author will decide the possible of free registration after getting the 
language resource files.



History
Apr 2001. Version 1.8
 · Added: Filter: Antialiasing.
 · Bug fix: Fixing problem with loading ceated serie in Create serie dialog.
 · Bug fix: Storing a serie target folder for useing in copy/move/create serie dialogs.
 · Added: Full screen view mode.
 · Added: /v (/V) command line parameter - start program in full screen view mode.
 · Changed: Updated protection module (no needed to change registration key).
 · Added: The image scolling then autozoom is off and image is larger than window size.
 · Bug fix: Undisabled Image menu subitems in slideshow mode.

Feb 2001. Version 1.7
 · Added: Ellipse filter.
 · Added: Portable pixel/gray map images library (*.ppm, *.pgm, *.pbm).
 · Changed: The hotkeys changed for more compatible with Windows standard.
 · Bug fix: The spelling mistakes are corrected.
 · Added: Download language files button in Configuration dialog.
 · Added: Confirmation message on file delete action.
 · Added: Folder history in Copy and Move/Rename dialogs.
 · Changed: Protection module.

Jan 2001. Version 1.6.1
 · Added: /s (/S) command line parameter - start a slideshow at startup.
 · Added: /f (/F) command line parameter - load all images in folder at startup.
 · Added: /m (/M) command line parameter - load all images in folder with subfolders processing at 
startup.
 · Changed: The image order in Open folder function - now images loaded in native OS order.
 · Bug fix: Problem with international hint on Run/Stop tool button at program start.

Dec 2000. Version 1.6.0
 · Added: Filters: Grayscale and Negative.
 · Added: Ascending and Descending sorting modes.
 · Added: Autoassotiation for PVL-files.
 · Changed: Copy and Rename/Move image dialogs updatet to more usefull.
 · Added: Creatye serie utility.
 · Changed: Added shortcuts topic into help.
 · Changed: Moving all language recources from instal package to web site (except english).

Nov 2000. Version 1.5.0
 · Buf fix: Fixing problem with setting icon or metafile as wallpaper.
 · Added: Open folder with subfolders flag.
 · Added: "Set as current" command in "Edit picture order dialog".
 · Added: Set small/large buttons in tool bar abitity.
 · Added: Flip image.
 · Added: Rotate image.
 · Added: Save image (BMP, GIF, JPG write support).

Oct 2000. Version 1.4.2
 · Bug fix: Correcting panels width on status bar.
 · Added: Replacing a long to display file path by "..." in status bar.
 · Added: Background bitmap on tool bar.
 · Added: Sorting in language select list in Configuraion window.

Sep 2000. Version 1.4.1
 · Bug fix: Fixing unregistered application crush with command line file loading.



 · Bug fix: Relative file names now expanding to full.
 · Bug fix: Internal error with language selection.
 · Added: Drug'n'drop interface with shell.

Aug 2000. Version 1.4.0
 · Bug fix: Window now not resizing then configuration changed.
 · Added: Bitmap library for DIB format.
 · Added: PNG Library.
 · Added: Sort pictures toolbutton on toolbar.
 · Added: Autosize picture duplicate to Options menu.
 · Added: BackGround color.

Jun 2000. Version 1.3.2
 · Changed: History.txt removed from setup package.
 · Added: Save last Copy/Move path.
 · Added: Special message on picture load error (damaged or missed file).
 · Added: Hyngary language.

Jun 2000. Version 1.3.1
 · Bug fix: PCX format in load picture dialog now avalable.
 · Changed: Replaced PCX library.
 · Changed: Updating Polish language.
 · Added: Bitmap library for RLE format.

May 2000. Version 1.3.0
 · Bug fix: Disable list operations while slide show is running.
 · Bug fix: Fix animated GIF's blinking.
 · Changed: Tool panel now is flat and auto resize for window width.
 · Changed: New registration order.
 · Added: Targa library (formats: *.TGA; *.VDA; *.ICB; *.VST).
 · Added: PhotoShop library (formats: *.PSD; *.PDD).
 · Added: Print current picture.
 · Added: PopUp menu in picture area.
 · Added: Sort picture list by file number.
 · Added: Polish language.

Apr 2000. Version 1.2.1
 · Bug fix: Problem with save registration info.
 · Bug fix: Hint on Edit order tool button.
 · Added: Italian language.

Apr 2000. Version 1.2.0
 · Bug fix: Undisabled commands First and Prevouse if on first picture.
 · Added: TIFF library.
 · Added: Save/Open picture list.
 · Added: Open files pointed in parameters.
 · Added: Set current picture as Windows desktop wallpaper.
 · Changed: Multilanguage architecture.
 · Changed: Open Folder dialog now use Windows browser with network support.
 · Changed: Copy file dialog now only select target folder.
 · Changed: Rename/Move dialog.

Feb 2000. Version 1.1.1
 · Bug fix: Refresh file list in Open folder dialog.
 · Bug fix: Disable Register page if already registred.



 · Added: Splash screen.
 · Added: Get RegKey button on Register page.
 · Added: Install/Uninstall utility.

Sep 1999. Version 1.1.0
 · Added: File manager (Tools menu).
 · Added: Replaced GIF library on more faster.

May 1999. Version 1.0.0
 · First public version - basic features only.



Technical support
Technical Support
By purchasing AD Picture Viewer, you will receive ongoing, preferred treatment by our technical support 
team, should the need arise! Please contact us by email at support@abroaddesign.com.

Feedback
If you have any comments or concerns about AD Picture Viewer please direct them to 
support@abroaddesign.com. Your feedback is important to us in order to get an idea of how to make AD 
Picture Viewer a better product for you. Many of AD Picture Viewer’s features and significant portions of 
user interface have been heavily influenced by comments from users. So if you have a grand idea for a 
new feature, or a better way of doing something, please drop us a note.



Overview
Introduction
AD Picture Viewer fhe fastest, easy-to-use and compact image viewer for Windows 95/98/NT! This viewer 
supports all popular graphic formats (BMP, JPEG, GIF/Animated GIF, PNG, PCX, TIFF, TGA, etc), 
support a picture list files and has a simple but powerful built-in file manager that allows you to copy, 
rename/move, delete images, modify images, create serie and set an image as a Windows desktop 
wallpaper.

Image viewing

Image manipulation

Image transformation

User interface

For up-to-date information on AD Picture Viewer see the our web site at http://www.abroaddesign.com.

Minimum system requirements:

Microsoft Windows 95 / 98 / NT 4.0 / 2000

Intel 486DX with 32 MB RAM

1 MB free disk space (and 2 MB for set wallpaper function)



License information
AD PICTURE VIEWER - PRODUCT LICENSE INFORMATION

NOTICE TO USERS: CAREFULLY READ THE FOLLOWING LEGAL AGREEMENT. USE OF THE 
SOFTWARE PROVIDED WITH THIS AGREEMENT (THE "SOFTWARE") CONSTITUTES YOUR 
ACCEPTANCE OF THESE TERMS. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, 
DO NOT INSTALL AND/OR USE THIS SOFTWARE. USER'S USE OF THIS SOFTWARE IS 
CONDITIONED UPON COMPLIANCE BY USER WITH THE TERMS OF THIS AGREEMENT.

LICENSE GRANT. Abroad Design grants you a license to use one copy of the version of this SOFTWARE 
on any one hardware product for as many licenses as you purchase. "You" means the company, entity or 
individual whose funds are used to pay the license fee. "Use" means storing, loading, installing, executing 
or displaying the SOFTWARE. You may not modify the SOFTWARE or disable any licensing or control 
features of the SOFTWARE except as an intended part of the SOFTWARE's programming features. 
When you first obtain a copy of the SOFTWARE, you are granted an evaluation period of not more than 
30 days, after which time you must pay for the SOFTWARE according to the terms and prices discussed 
in the SOFTWARE's documentation, or you must remove the SOFTWARE from your computer. This 
license is not transferable to any other hardware product or other company, entity, or individual.

OWNERSHIP. The SOFTWARE is owned and copyrighted by Abroad Design. Your license confers no title 
or ownership in the SOFTWARE and should not be construed as a sale of any right in the SOFTWARE.

COPYRIGHT. The SOFTWARE is protected by United States copyright law and international treaty 
provisions. You acknowledge that no title to the intellectual property in the SOFTWARE is transferred to 
you. You further acknowledge that title and full ownership rights to the SOFTWARE will remain the 
exclusive property of Abroad Design and you will not acquire any rights to the SOFTWARE except as 
expressly set forth in this license. You agree that any copies of the SOFTWARE will contain the same 
proprietary notices which appear on and in the SOFTWARE.

REVERSE ENGINEERING. You agree that you will not attempt to reverse compile, modify, translate, or 
disassemble the SOFTWARE in whole or in part.

UNAUTHORIZED USE. You may not use, copy, rent, lease, sell, modify, decompile, disassemble, 
otherwise reverse engineer, or transfer the SOFTWARE except as provided in this agreement. Any such 
unauthorized use shall result in immediate and automatic termination of this license.

BUNDLING. In no case may this product be bundled with hardware or other non-shareware software 
without written permission from Abroad Design.

All distribution of SOFTWARE is further restricted with regard to sources which also distribute virus 
source code and related virus construction/creation materials. The SOFTWARE may not be made 
available on any site, CD-ROM, or with any package which makes available or contains viruses, virus 
source code, virus construction programs, or virus creation material.

Permission to distribute the SOFTWARE is not transferable, assignable, saleable, or franchisable. Each 
entity
wishing to distribute the package must independently satisfy the terms of the distribution license.

LIMITED WARRANTY. THIS SOFTWARE IS PROVIDED ON AN "AS IS" BASIS. ABROAD DESIGN 
DISCLAIMS ALL WARRANTIES RELATING TO THIS SOFTWARE, WHETHER EXPRESSED OR 
IMPLIED, INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTIES OF MERCHANTABILITY 
OR FITNESS FOR A PARTICULAR PURPOSE. NEITHER ABROAD DESIGN NOR ANYONE ELSE 
WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF THIS SOFTWARE 
SHALL BE LIABLE FOR ANY INDIRECT, CONSEQUENTIAL, OR INCIDENTAL DAMAGES ARISING 
OUT OF THE USE OR INABILITY TO USE SUCH SOFTWARE, EVEN IF ABROAD DESIGN HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR CLAIMS. THE PERSON USING THE 



SOFTWARE BEARS ALL RISK AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE.

SOME JURISDICTIONS DO NOT ALLOW LIMITATION OR EXCLUSION OF INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS OR EXCLUSION MAY NOT APPLY TO 
YOU TO THE EXTENT THAT LIABILITY IS BY LAW INCAPABLE OF EXCLUSION OR RESTRICTION.

IN NO EVENT SHALL ANY THEORY OF LIABILITY EXCEED THE LICENSE FEE PAID TO [COMPANY].

SEVERABILITY. In the event of invalidity of any provision of this license, the parties agree that such 
invalidity shall not affect the validity of the remaining portions of this license.

NO LIABILITY FOR CONSEQUENTIAL DAMAGES. IN NO EVENT SHALL ABROAD DESIGN OR ITS 
SUPPLIERS BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, SPECIAL, INCIDENTAL OR INDIRECT 
DAMAGES OF ANY KIND ARISING OUT OF THE DELIVERY, PERFORMANCE OR USE OF THE 
SOFTWARE, EVEN IF [COMPANY] HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 
IN NO EVENT WILL ABROAD DESIGN LIABILITY FOR ANY CLAIM, WHETHER IN CONTRACT, TORT 
OR ANY OTHER THEORY OF LIABILITY, EXCEED THE LICENSE FEE PAID BY YOU, IF ANY.

This agreement will not be governed by the United Nations Convention on Contracts for the International 
Sale of Goods, the application of which is expressly excluded.

ENTIRE AGREEMENT. This is the entire agreement between you and Abroad Design which supersedes 
any prior agreement or understanding, whether written or oral, relating to the subject matter of this 
license.

RESERVED RIGHTS. All rights not expressly granted here are reserved to Abroad Design.



Purchasing by Internet
You can order online by following this link:

https://secure.element5.com/register.html?productid=131335

Payment can be made using one of the following credit cards:

MasterCard

VISA

American Express



Purchasing by telephone

If using telephone orders, please include product ID: 131335 to ensure that you are paying for 
the right product.

Telephone

The US only: 724-850-8186
International: +49-221-240-7279 

Operators are standing by to take your order 24 hours a day, every day of the week.

Payment can be made using one of the following credit cards:

MasterCard

VISA

American Express



Purchasing by FAX

If using fax orders, please include product ID: 131335 to ensure that you are paying for the right 
product.

Fax

The US only: 724-850-8187
International: +49-221-240-7278 

Operators are standing by to take your order 24 hours a day, every day of the week.

Payment can be made using one of the following credit cards:

MasterCard

VISA

American Express



Starting program
Starting program
You can start AD Picture viewer by clicking on the corresponding icon on the Start Menu.

Command line parameters
Default behavior (no arguments)
When no command line arguments are given, AD Picture Viewer in the current folder.

Specifying images to load
You can supply one or more image files as the command line argument to AD Picture Viewer.
e.g., picview d:\myimages\image.jpg start AD Picture Viewer and have it load image.jpg file in the d:
\myimages folder.

Note:
1. If any filename includes spaces, you must enclose it in quotation marks:
e.g., picview "my image.bmp"
2. Relative path are also supported (AD Picture Viewer extent them to full path):
e.g., picview ..\myimages\myimage.jpg

Specifying Picvure Viewer List file to load
Like a images you can supply one or more Picture Viewer List files as the command line argument to AD 
Picture Viewer,
e.g., picview d:\myimages\images.pvl start AD Picture Viewer and have it load all images describing in 
images.pvl file.

Specifying folder to load
Then you neet to load a all images in folder at sturtup you can enter in a command line a /f key for loading 
all images in pointed folder without subfolder processing and /m to loading with subfolder processing.
e.g., picview /fsomefolder start AD Picture Viewer and load all images from somefolder folder;
picview /motherfolder start AD Picture Viewer and load all images from otherfolder folder and them 
subfolders.

Specifying to start slide show
If you load all needed images in AD Picture Viewer as a command line parameters you can command AD 
Picture Viewer to start slide show at sturtup. For this add a /s key to a command line.
e.g., picview /fsomefolder /s start AD Picture Viewer, load all images from somefolder folder and start 
a slide show.

Note:
1. You can supply as images as pvl files in one time,
e.g., picview d\myimages\image.jpg d:\myimahes\images.pvl start AD Picture Viewer and have it load 
image.jpg and images.pvl files in the d:\myimages folder

Specfying full screen mode
If you want to start AD Picture Viewer in full screen mode add /v command-line parameter.
e.g., picview /fd:\myimages /s /v start AD Picture Viewer with fuul screen, load a contents of d:\myimages 
folder and start slideshow mode.



Image list
The image list files that you can generate allow you to re-open the sequence on another occasion to see 
the images again. AD Picture Viewer automatically create a image list then you open any images.

Saving the image list to a file

You can save the current image sequence to a file using the File|Save list command or useing  tool 
button. AD Picture Viewer save a list of current opened images in current order as a Picture Viewer List 
(PVL) file for feature using.

Recalling an image list from a file
From the AD Picture Viewer, you can read the images stored in an image list (PVL) file using the File|

Open list command or  toll buttton. You can also open an image sequence by dragging and dropping 
the PVL file into the View area.

Editing the image list

You can edit an image list with help a same automatic sort commands (Image List|Sort submenu or  
tool button) and manualy in special order editor (Image List|Edit order menu item or 

 tool button). Sort commands allow you to sort current loaded images on one of property:

by file name - in alphabetical order sort images file names with out paths;

by full name - in alphabetical order sort images file names with paths;

by file number - extracts all digits from file name, convert to file number and sort as a numbers.

For example, if loaded three images with names:

C:\Images\img1.jpg

C:\Images\img10.jpg

C:\AllImages\pic5.jpg

After sort by names image list is:

C:\Images\img1.jpg

C:\Images\img10.jpg

C:\AllImages\pic5.jpg

After sort by full names image list is:

C:\AllImages\pic5.jpg

C:\Images\img1.jpg

C:\Images\img10.jpg

After sort by file number image list is:

C:\Images\img1.jpg

C:\AllImages\pic5.jpg

C:\Images\img10.jpg

See also
Image list editor



Print image
There are 2 ways to print current picture.

The 1st is use a  tool button. In this case AD Picture Viewer print current image on active printer with 
current printer settings.

The 2nd is ude a Print item of File menu. In this case before printing image you see a printer setup dialog. 
In this dialog you can change any options like: select printer, choose paper orientation, select a number of 
copies you need and some other. After clicking onn Ok button AD Picture Viewer print current image with 
using a new settings.

Note:
1. AD Picture Viewer print images as is if the phisical size of them less then phisical size of paper. In other 
case before printing AD Picture Viewer scale image to fit in printing area.



Drag-in images
AD Picture Viewer partially support a Dgug'n'Drop interface with OS shell. You can drop image files from 
other programs on AD Picture Viewer main window and this images will be loaded into program. Also 
except image files AD Picture Viever can accept a Picture Viewer List (PVL) files.

For example:
1. Start a AD Picture Viewer and Windows Explorer.
2. Select any image or PVL files in Explorer.
3. Take selected files by mouse and drag them other a AD Picture Viewer main window. The mouse 
cursor will be changed. If you don't see a AD Picture Viewer's main window move mouse on program's 
button on Task Bar and hold it there some time - Windows bring to front a main window of AD Picture 
Viewer. Then move moust other it.
4. Drop files on AD Picture Viewer.

After this AD Picture Viewer load dropped files.

See also
Image list (PVL)



Slide show
Slide Show Commands and Features
You can perform a slide show whenever more than one image is in the image sequence. When some 
number of    images or Picture Viewer List file is opened in the Viewer, the window status bar indicates the 
number of images in the list and the sequence number of the current image.

In the status bar of the View window there is an indicator reading "c/n", where n denotes the number of 
images in the list and c denotes the sequence number of the currently viewed image.

Starting and stopping the slide show

For starting a slide show click on  button on toolbar or use Run item in View menu. Then slide 
show started the Run menu item and tool button will be changing to Stop menu item and 

 tool button.

To stop slide show click on  tool buton or use Stop item in View menu. Then you stop slide 
show the menu item and tool button will be changed reverse to Run menu item and 

 tool button.

Manual swith between images
Then slide show mode is not running you can shitch between loaded images manualy. Use following 
command to switch between pictures:

First item in View menu or  tool button switch to first loaded image.

Previouse item in View menu or  tool button shitch to previouse loaded image.

Next item in View menu or  tool button switch to next loaded image.

Last item in View menu or  tool button switch to last loaded image.

Note:
In depends of slide show options the Next command at the end of loaded images list and Previouse 
commant at the top of loaded images list may be disabled. If they are enabled then you click on the tool 
button or select a Next or Previouse menu item will be loaded the image from the opposite end of loaded 
images list.

Adding images to the image sequence
AD Picture Viewer support one global image sequence. For adding images in them stop slide show and 
use Open, Open folder and Open list command to loading images in image sequence.

See also
Image loading
Image list
Slide show options



Image loading
AD Picture Viewer support a same variants for loading images.

Load with command line parameters help

Load with Open and Open folder menu command or tool buttons.

Load a Picture Viewer List files.

Load with Drag'n'Drop help.

Also AD Picture Viewer contain a Close and Close all commands and tool buttons. A Close command 
delte from list of loaded images (not from disk) a current image. and the Close all command clear a list of 
loaded images.

See also
Command line parameters
Open
Open folder 
Picture Viewer List 
Drag'n'Drop 



Copy image file
The Tools|Copy file commands (short cut F5) allow you to copy current file to a different folder with new or 
old file name. Upon invoking the command, a dialog box appears allowing you to specify the target file 
name.

The Browse.. button call a file select dialog and the On file exist combobox allow you to choose an AD 
Picture Viewer action then the target file already exist. By default this action is overwrite existing file by 
coping file. Also you can choose a Ask action. then AD Picture Viewer confirm you to overwrite file if it 
exist. And the 3rd case - Leave ald. In this case AD Picture Viewer leave existing file if it exist and abort 
coping.
After selecting the target folder AD Picture Viewer copy a image file in them.

Note:
1. After coping the old file is stay as a loaded in AD Picture Viewer.
2. A default folder for coping file is a saved prevouse copy or rename/move folder.



Rename or Move image file
The Tools|Move/Rename file commands (short cut F6) allow you to move or/and rename current file to a 
different folder and file name. Upon invoking the command, a dialog box appears allowing you to specify 
the target folder and a new name.

The Browse.. button call a file select dialog and the On file exist combobox allow you to choose an AD 
Picture Viewer action then the target file already exist. By default this action is overwrite existing file by 
renaming/moving file. Also you can choose a Ask action. then AD Picture Viewer confirm you to overwrite 
file if it exist. And the 3rd case - Leave ald. In this case AD Picture Viewer leave existing file if it exist and 
abort renaming/moving.
AD Picture Viewer save a ahort history of previouse used target folders. You can select one of them by 
clicking on it in a Previouse destination folders list. Select a needed folder by one click and apply this as s 
current path by double ckicking.
After selecting the target folder and a new name AD Picture Viewer rename or/and move a image file in 
target folder with new name.

Note:
1. After coping the new file is stay as a loaded in AD Picture Viewer even if the old file wasn't deleted (for 
example from CD-ROM).
2. A default folder for coping file is a saved prevouse copy or rename/move folder.



Delete image file
You can delete a current image from disk with help a Tools|Delete file command (short cut F8). Be careful 
with this command becouse file will be deleted with out useinr a recicle bin.



Set image as wallpaper
The Wallpaper commands allow you to set the wallpaper shown on the Windows desktop to any image. 
The current image is first converted to BMP format and then saved as "pv_wp.bmp" in the AD Picture 
Viewer folder. After that AD Picture Viewer change the wallpaper settings in Control Panel to display this 
image.



Coping to clipboard
AD Picture Viewer can copy current image or file name of them into system clipboard. For coping some 
information use a Copy to clipboard subitems of Tools menu:

 Copy image (short cut Ctrl+C) - copy current image self.

 Copy file name - copy a file name of current image.

Copy full path - copy file name of current image with full path to them.



Flip image
The Image|Flip horizontal and Image|Flip vertical menu items allow you to flip current image. This menu 
items will be accessible if current image is not WMF, EMF or ICO format.

Note:
1. Don't foget save modified image - all changes will be processing on copy of image in memory and will 
be lost then you switch to another image.



Rotate image
You can rotate a current image by using Image|Rotate submenu. There are four items to rotate image:

180° - allow you to rotate image on 180°;

+90° - allow you to rotate image on 90° clockwise;

-90° - allow you to rotate image on 90° anticlockwise;

Free - allow you rotato to free angle.

In the Free rotation dialog you can point the angle to rotate image in Rotate angle field (accept integer 
values) and background color for filling empty fields in not 90° rotation (in rotation the AD Picture viewer 
make image size is lalger for new image).

The Apply button rotate a image in main window as a preview. The OK button close dialog and accept 
rotation (if you don't use the Apply button before the OK button also rotate image). The Cancel button 
drop all changes. All rotation in this dialog are baset on sourse image. For example if you apply first 
rotation at 1° and after apply rotation on 5° the result rotation will be a 5°.

Note:
After accepting rotation don't forget to save modified image. Overwise the all chganges will be lost then 
you switch to another image or close this image.

Note:
1. Don't foget save modified image - all changes will be processing on copy of image in memory and will 
be lost then you switch to another image.

See also
Save modified image



Save modified image
After changin current image you can save it over a old file or as a new file. Then you save it as a new file 
the old file name will be replaced by new in images loaded list.

Then you save a picture - you can select a one of supported to write format. Just select one of them in 
Filter combobox, enter a file name and click on OK button.



Main window options

Use a Options|Configuration menu item or  tool button to call a Configuration dialog that allow you to 
customize AD Picture Viewer. The Window page allow you to customize a main program window.

A System bars group set a visible of Tool bar and a Status bar. aslo you can set a large buttons property 
for tool bar (the tool bottons will be with discribing captions).
A Window state group allow you to set a window self parameters. If Maximized button is selected AD 
Picture Viewer will start with maximized main window and if Normal button is selected then AD Picture 
viewer start with last position and size. If Stay On Top check box is checked then program's main window 
try to be uppon all other window.
The Background sample field and Select button allow you to select a color for filling a viewable area.
And a Autosize checkbox control the autosizing method that if checked scale a displaying image to fit in 
current size of viewable area.

Note:
The ToolBar, statusBar and Autosize checkbox are duplicate in Options menu to quick switching.



Slide show options

Use a Options|Configuration menu item or  tool button to call a Configuration dialog that allow you to 
customize AD Picture Viewer. The SlideShow page allow you to customize a slide show mode params.

The Delay group allow you to set a pause between showing one image from list of loaded images after 
another. The left side of ruller set a 1 second and the right side set a 10 seconds of pause.
The siquence group contain a controls that set a direction of image changing. The Forward button set a 
incremetal switching (from first loaded image to last) and the Reverse button set a decremental switching 
(from last loaded image to first). Also the Cycle check box control the cycling of loaded images list. If it's 
checked the AD Picture Viewer go to the opposite end list then the first (in decremental swithcing) or last 
(in incremental switching) begin to change. If Cycle check box is not checked ythen AD Picture Viewer 
stop slide show mode then first or last image is displayed.



Interface language selection
AD Picture Viewer support multilanguage interface. For select a your prefer interface lanuage open 

configuration window using Options|configuration menu item or  tool button and go to the Language 
page.

In this window select one of displayed language and click OK.

For download new language resources click on Download language resource button. The internet 
browser will be opened with internation language supporting page of AD Picture Viewer home page. 
Select a needed language and download it. Unpack by useing any ZIP unarchiver a resource file into AD 
Picture Viewer install folder and restart program. After this in above shown dialog a new language will be 
available.

See also
Multilanguage support



How to conver image to another format
If you need to convert an image to another format you can use a Image|Save as menu item for this. 
Select a one of supported write format im Filter combobox and click OK.

See also
Save image



Uninstalling AD Picture Viewer
You can remove AD Picture Viewer from your system as follows:

1 Open the Windows Control Panel.

2 Double click on [Add/Remove Programs].

3 Find AD Picture Viewer in the list, and double click on it.

4 Follow the instructions in the Uninstall Wizard.

Or

1. Click on Start button, open Start menu and go to Programs submenu.

2. Find AD Picture Viewer Group and open it.

3. Click on Uninstall AD Picture Viewer icon.

4. Follow the instructions in the Uninstall Wizard.



Open images

The File|Open command or  tool button allow you to open one ore more files in single folder at one 
time. Upon invoking the command, a dialog box appears allowing you to specify the files to loading.

You can select a format filter to filter images in folder by fthem format. For selecting a more then one 
image use a Shift and Ctrl keys. If you want to select all images between 2 files - select a first bound 
image, hold a shif key and select a last bound image. If you want to select a several images - select a first 
image, hold Ctrl key and select other images.



Open folders

The File|Open folder command or  tool button allow you to open all supported    files in selected folder 
and in them subfolders . Upon invoking the command, a dialog box appears allowing you to specify the 
high level folder to loading images.

If Include subfolders check box is checked then AD Picture Viewer images to open search recurse in 
subfolders of selected folder. After finding all loadable images them will be sorted by full file name before 
loading into AD Picture Viewer..



Image list editor
The Image list editor allow you to edit order of loaded images manualy. Call it by Image List|Edit order 

menu command or use  tool button.

For edit image order in list select a it and use arrow button to move image. The first button move image to 
a top of list, second button move image at one position hier, the third button move at one position lower 
and the fourth button move image to the end of list.
The Sett as current button set selected image as current displayed in view area. The OK button apply 
changes and the Cancel button drop all changes.



Image filters
The Image|Filters menu contain a same submenu that allow you to modify current image with help one of 
filters. This menu items will be accessible if current image is not WMF, EMF or ICO format.

Now supported following filters:

Antialiasing - removing of sharp borders

Ellipse - ellipsing image.

Grayscale - drop information about colors.

Negative - invert all colors and make a negative image.

Note:
1. Don't foget save modified image - all changes will be processing on copy of image in memory and will 
be lost then you switch to another image.



Create serie
The Create serie dilog (calling by Tools|Create serie menu) allow you to copy all loaded images into 
another folder with unified file names. Before creating serie you can sort loaded files with automatic 
sortings or by Edit order dialog - the Create serie    function will create serie with current image list order. 
You select a fila name prefix, postfix, start number and number step.

Enter a folder for saving serie in New serie folder field (use Browse.. button to call a select folder dialog). 
This folder must be exist. After that enter a Prefix and Postfix of new file names. This field can contain an 
empty values. In this case new file names will be contain only number.
The Start from number set a number of first file and the Step set a difference between 2 nearest file 
numbers. The file numbers are generatet in ascending direction. The Leading zeros checkbox enabling 
the generating a constant length numbers. Then this function activated the numbers will be generated 
with leading zeros to fiil to pointed in Number length field length.
The On file exist options allow you to select an reaction of Create serie function on target file existing. In 
Overwrite case function try to overwrite existing file by new, in Ask case AD Picture Viewer ask you to 
overwrite existing file and in you select a No then new file name will be generated for current coping file, 
in skip number Create serie function automatically create new number for current image if target file 
already exist.
The    after creating options allow you to select an action afer creating serie. In Leave current list case AD 
Picture Viewer keep a curen loaded list and in Load created serie case AD Picture Viewer close current 
list and open created serie (created serie opened like open folder without subfolders).
If any error in copy process accure the Create serie function ask you to abort process. If you don't abort 
process this function skip the curent number and try to continue operation.

Examples:

Example 1:
Source files have bmp format
Loaded 20 images
Prefix=serie1_
Postfix=_image
Start number=1
Step=1
Leading zeros=off
Result:

Example 2:
Source files have bmp format
Loaded 20 images
Prefix=photo
Postfix=
Start number=0
Step=10
Leading zeros=on
Number length=3



serie1_1_image.bmp
serie1_2_image.bmp
...
serie1_10_image.bmp
...
serie1_50_image.bmp

Result:
photo000.bmp
photo010.bmp
...
photo100.bmp
...
photo190.bmp

Note:
This function only copy files with new name and leave file format and file name extentions.

See also
Image list
Edit order dialog



Keyboard shortcuts

Key Function
Ctrl+O Open
Ctrl+Alt+O Open folder
Ctrl+Q Close
Ctrl+Alt+Q Close all images
Ctrl+L Open image list
Ctrl+S Save image list

Ctrl+P Print image
Ctrl+F2 Copy image
F2 Rename or move image
Del Delete image
Ctrl+C Copy image to clipboard
F5 Refresh (reload) image

Home Go to first image
End Go to last image
PgUp Go to prevouse image
PgDn Go to next image
F9 Run/stop slideshow

F11 Full screen view mode on/off

F1 Help index
Alt+F4 Close program




